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Appendix E  
E.1 Instructions for Using Falcon V6 

Falcon V6 now has a new look.  If you are familiar with using Windows Explorer then 
you will not have any problems with the new Falcon.  There is only one form of Falcon 
now called DocMan.  It works inside MicroStation and outside as well. 

        

E.1.1 Falcon/DMS DocMan (Overview) 

The DocMan user interface for the Falcon/DMS document management suite is a 
“panes-based” application used to manage, search for and view documents.  The 
panes can be resized and toggled on and off in various combinations to produce an 
interface that is easily configured for different document management tasks.  The 
DocMan’s Windows Explorer- like interface allows you to view both files and 
information stored in each document’s database record and to easily identify a 
documents “Availability”.  

The interface components fall into three categories: panes, toolbars, and menus 
(shortcut- or context – and dropdown). 

The toolbar contains commands that permit you to control the display of panes (that 
allows you to “organize” the interface). You should familiarize yourself with the toolbar 
operations first. 
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E.1.1.1 The Toolbars 
 

             

Under File you have all the document functions – open, check out, copy etc.   
Environments are now located under Databases.  

                                   

Under Databases pick the district you want. 

         

 

A dropdown for Environments appears only if you choose Central Office no other 
database i.e. district will cause it to become part of the toolbar. Environments is 
where you will find Archives, Consultant Files, Plan File Room ,Priority Letters, etc.  
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The Tools dropdown is where Mass Update is located. The others will be discussed in 
E1.1.2. 

 

E.1.1.2 Panes Toolbars 

       

The Panes toolbar (above) controls the display of the DocMan’s panes and, in several 
cases, the type of information they contain.  For example, pane 1 can display either a 
search form or a folder hierarchy; pane 2 can display the DocList by itself or with 
notes. 

Search Sets the mode for pane 1 to Quick Search. 

Folders Sets the mode for pane 1 to Folder View (the default). 

Viewer Toggles the display of the Viewer in pane 2.  (When the 
Viewer is off, it is replaced by the DocList.) 

DB Tabs Toggles the display of the Database Property Tabs in pane 3. 

Doc.List 
Toggles the display of the DocList.  (When the Viewer is off, 
the DocList displays in pane 2; when the Viewer is on, the 
DocList displays in pane 4.) 

Notes Toggles the display of Notes beneath the DocList. 

View 
Document 

The View Documents command displays the selected 
document in its own viewing window. 
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E.1.2 Panes 

The DocMan interface is comprised of panes that can be toggled on and off, replaced, 
and depending upon the pane, resized. 

The default DocMan configuration (below) uses three panes.  Because the Viewer is 
not active in the default configuration, the View command opens a floating window to 
display the selected document. 

DocMan’s Default panes configuration 

                

 

 

Pane 1 is set to Folders mode – also referred to as Folders View; click Search 
to switch to Search mode. 

Pane 2 contains the DocList (Document List). 

Pane 3 contains the Database Properties Tabs. 

The floating Viewing Window opens when you select a document and then 
choose View. 

 

Pane 1 

Pane 2 

Pane 3 
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E.1.3 Locating Documents (View/Search) 
The DocMan provides two methods for locating documents: 

Folders View                                               Quick Search 

                              

Folders View – (above, left) pane 1 displays the hierarchical structure of folder and 
files in a fashion similar to that of the Windows Explorer. 

Quick Search – (above, right) pane 1 displays a form which allows you to use the 
descriptive information stored in each document’s database record. 

E.1.3.1 Folders View 
When in Folders View (or Folders mode) the DocMan is similar in both appearance 
and behavior to the Windows Explorer. 

Checked Out to User – Click this item to display all the documents checked out to 
you.  This feature is especially useful when you have checked out files from 
multiple folders.  You can perform all the management commands valid for 
checked out documents from this list. 
Projects – Expand the Projects folder to display all the projects to which you 
have access.  As with the Explorer, you can expand project folders to show their 
subfolders. 
Local Documents – Expand the Local Documents folder to display all the folders 
located in the area on your workstation to which the DocMan has access.  This is 
used primarily for creating database records for local documents.  When local 
files are added to the database the selected files are automatically moved to user-
designated folders on the file server. 
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E.1.3.2 Quick Search 
While Quick Search can produce results based on as little as a portion of a filename 
(e.g. *.dgn) and perhaps some location information (e.g. project folder), Falcon makes 
a lot of descriptive information available in order to produce increasingly refined 
results.  The categories of descriptive information include an actual document 
description, status information, access information, and keywords, among others.  
Typically, the Quick Search form contains fields representing the most common 
criteria for documents controlled by Falcon; the number and types of fields differ 
substantially or only slightly between environments. 

Database Keyword – An important element in defining or redefining search criteria is 
the database keyword.  A keyword is an attribute assigned to a document’s database 
and grouped by category. A database keyword category can present a list of 
predefined keywords on a drop-down menu (e.g. Sheet Type), or can appear as a text 
field.  A keyword category that appears as a text field (e.g. Contract #, Plat #) usually 
indicates a category for which a list would be too long and cumbersome to manage or 
use. 

The search forms use two field types: 

Text Field This field type allows you to key in a search value. UPC #, 
Description and File name are examples of Text fields. 

Drop-down menu 
This field type allows you to enter a search value or select a 
value from a drop-down menu.  UPC # is an example of a 
drop-down menu. 

E.1.4 Open & Checkout 
To open a file just highlight the file, right mouse click and select Open (Modify). 

To check out to modify you would highlight all the files you want to check out, then 
right mouse click and select checkout (Modify). 
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E.1.4.1 Reference File Check and IGRDS Files 
The reference file check is under References at the top of the DocMan screen.  It is 
turned on when the check is shown to the left. 

        

E.1.4.2 Checking In Files 
You can navigate to Local Documents or Checked Out To by highlighting the file or 
files and right mouse click and pick Check In.  

E.1.4.3 Creating New Files 
To create a new file, navigate to your project and the division, then right mouse click.  
Select New – IGDS Document. 
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You will get the box below.  Pick the correct seed file.  Then click Next. 

              

 

You will get the box below.  Fill in the Filename, Document Number and Description 
and any other information you may know.  Then click Next.  
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At the bottom you have Options to Create Document, Create/Checkout Document 
or Create/Open Document.  Pick one and then click Finish. 

                

E.1.4.4 Add Local Document 
You must navigate to the Local Documents folder - c:\documents\cfms_local.  The 
file must be in this directory.  Highlight the file and right mouse click.  Pick   Add – 
Add Local Document.   
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Then you will get the box below.  The Filename will be filled in with the name of the file 
you are adding.  Document Number must be the sheet number if the file is a sheet 
file.  If not Document Number should be left blank.  Then pick the correct File 
Format.   
On the left side of the box double click on the PROJECTS folder and navigate to the 
UPC number and directory you want to add the file.  You can fill in any of the tabs 
below then click Next.   
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Make sure the file is going to the right place and toggle on the Checkin Document at 
the bottom of the box then click Finish. 

 

E.1.5 Attaching Reference Files 
Use Falcon to open (modify) the master file. Once you have the master file open in 
MicroStation, open Falcon and highlight the file you want to reference then click on 
MicroStation in the Falcon/DMS menu bar and select Attach Reference 
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Then click on attach reference.   The box below will open.   

Fill in the Logical name by following the table on page E-17 to make sure that your 
Logical Name is the correct one for the type of file you are referencing, If not you file will 
not plot correctly. For more information on Logical Names see Chapter 3 Section 
3.11.2.1. 

Make sure the following information is set: 
Orientation – Coincident – World  
Scale (Master:Ref) – 1.000 : 1.000 
Nested Attachments – (See options below) 
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No Nesting Display no references from attached references. 
Only the reference you select is seen. 

Live Nesting Provides the ability to see the reference of a 
reference. The nesting level can be changed 
dynamically for each reference. Only the 
references you select are seen. The reference 
of a reference attached this way does not 
display in the reference dialog box. 

Copy Attachments, Depth of 0 A nesting depth of 0 displays no references from 
attached references. Only the reference you 
select is seen. 

Copy Attachments, Depth of 1 A nesting depth of 1 attaches the files and 
also attaches the reference of the reference to 
the current file. 

  

When using the live nesting option open the Preferences dialogue box in the 
Falcon/DMS menu bar by selecting Tools>Preferences.   

 

 

 

Once the Preferences dialogue box is opened, make sure the Download Nested 
References is turned on and Levels of Nested References is set to 2. As shown 
below. Now click OK. All users associated with project need to turn on these options.  
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Now click OK on the Reference Attachment Settings dialogue box. The file(s) will be 
attached.  
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The command for detaching a reference file is found under the MicroStation menu bar. 
File > Reference > Tools. 

 

  

Remember: Logical 
Name has to be filled 
in if you are 
referencing, If not your 
file will not plot 
correctly 
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VDOT File Referencing for Plotted Files 

File Name Description Logical Name 
How the file is 

Plotted with the 
Pen Table 

d + UPC#.dgn Roadway Design 
File Design - Roadway 

Modifies the Line 
Weight (2) and 
shades the file 
(approximately 
75%). 

h + UPC#.dgn Drainage Design 
File Design - Drainage 

Modifies the Line 
Weight (2) and 
shades the file 
(approximately 
75%). 

 For all other design 
files 

Design - XXX 
(where XXX is a 
description of the 
file) (Examples 
include Alignment, 
Baseline, Notes, 
Pattern, Proposed 
R/W, etc.) 

Modifies the Line 
Weight (2) and 
shades the file 
(approximately 
75%). 

s + UPC#.dgn Survey File Survey 

Modifies the Line 
Weight (0) and 
shades the file 
(approximately 
50%) 

su + UPC#.dgn Survey Utility File Survey - Utility 

Modifies the Line 
Weight (0) and 
shades the file 
(approximately 
50%) 
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VDOT File Referencing for Plotted Files 

File Name Description Logical Name 
How the file is 

Plotted with the 
Pen Table 

 For all other survey 
files 

Survey - XXX 
(where XXX is a 
description of the 
file) - (Examples 
include Existing 
R/W, Existing 
Easements, 
Underground Utility, 
etc.) 

Modifies the Line 
Weight (0) and 
shades the file 
(approximately 
50%) 

t + UPC# + ts.dgn Traffic Signal 
Master Design File TS Master  

t + UPC# + lt.dgn Lighting Master 
Design File LT Master  

t + UPC# + tms.dgn ITS/TMS Master 
Design File TMS Master  

t + UPC# + si.dgn Signing Master 
Design File SI Master  

t + UPC# + pm.dgn Pavement Marking 
Master Design File PM Master 

Shades the existing 
Pavement Markings 
(approxmately 
45%). 

t + UPC# + pm.dgn 

If you would like the 
Pavement Markings 
to be Shaded (i.e. 
in a Signal Sheet 
File) 

Shade - PM Master 
Shades the file 
(approximately 
75%). 

t + UPC# + 
pmleg.dgn 

Pavement Marking 
Legend File Legend - PM  
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VDOT File Referencing for Plotted Files 

File Name Description Logical Name 
How the file is 

Plotted with the 
Pen Table 

t + UPC# + 
XXX.dgn 

Any general traffic 
reference required 
to complete the 
design plans 

TRAF - XXX (where 
XXX is a 
description of the 
file) - (Examples 
include Sign Figure 
Details, Pavement 
Marking Details, 
etc.) 

 

t + UPC# + 
XXleg.dgn 

Any other Legend 
File required to 
complete the 
design plans 

Legend - XX 
(where XX is a 
description of the 
file) 
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E.1.6 Mass Update 
The following steps can be used to update multiple database fields for multiple files in 
Falcon.  Activate DocMan, and then navigate to the appropriate UPC folder.  Select 
the files you wish to update.  Then go to Tools –Mass UpdateTools- Mass Update 

 

The box below will open.  You can move this box out of the way if necessary.  Click in 
the blank field under one of the database tabs (General Information, Directories & 
Keywords, etc.) that you wish to update.  Key in the information and then click the 
Process button. 

                                  
Then you will get this box, just click OK. 

                                           
The information will be saved  
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E.2 Falcon Database 

E.2.1 Falcon Database Information 

E.2.1.1 Purpose  
This document provides standard procedures for filling in the Falcon Document Management 
System’s required database fields.  
 
E.2.1.2 Scope  
The database information that Falcon provides will be extracted and used by other 
programs in the electronic plan process. The major uses for the Falcon database 
information are:  
 

 Producing an Index of Files  
 Status = index  

 
 Archiving files at different stages of the Project Development Process 

 Preliminary Field Inspection 
 Public Hearing  
 Right of Way Total 
 Field Inspection  
 Right of Way Partial 
 Adv. Submission 
 Pre Award Revision  
 Construction Revision  
 As Built Plans  

 
S&B will always archive files at Plan Submission, Revisions and As Builts and may 
occasionally need to archive files at one of the other stages, depending on the project.  
 

 Automatic PDF file generation for Electronic Plan Submission  
 PDF file created by designer are automatically renamed and placed 

into Plan File Room environment.  
 
It is very important to follow these instructions and complete the database information as 
soon as possible so it does not cause any delays to a project’s schedule. 
  
Falcon is used statewide. It is used to share files between multiple disciplines. Designers 
should be as informative as possible when entering descriptions since someone 
searching for a document may use the descriptions.  
 
The remaining portion of this document provides illustrations and procedures to follow 
when filling out the required database fields. If you need more assistance or have 
questions that were not answered, please call the CADD Support Helpdesk at 
(804)786-1280 or send an e-mail to: mailto: CADDSupport@VDOT.Virginia.gov 

mailto:CADDSupport@VDOT.Virginia.gov
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E.2.1.3 Information to Send with Submittal to CADD Support 

The Project Manager or Designer should send an e-mail to the Helpdesk prior to 
submitting PDF’s for the first time.  Since Tier 1 projects do not go through Plan 
Coordination Review, this allows CADD Support to get the files in the right 
location on Falcon Web. This is an example of the information that should be 
included in the email. 

 
• Description – rte. #### over ABC river, etc  
• Project location – District and county  
• Project #  
• UPC # (File location in Falcon if different from UPC#)  
• Plan #  
• Bridge # - (Federal Structure # is a five digit number)  
• Point of contact  
• Stage of Project – PAC/PRELIMINARY, PLAN COORDINATION REVIEW, 

ADVERTISEMENT SUBMISSION, CONSTRUCTION REVISION, or AS-
BUILT  
 

All subsequent e-mails need only reference the UPC# or Bridge Plan #. 
 
The following links provide additional guidance. 

 
Projects Submitted For Advertisement 

 

 
Tier 1 Projects 

 
Tier 2 Projects 

 
Projects Submitted For Pre-Award Revisions 

 
 

Tier 1 Projects 
 

Tier 2 Projects 
 

Projects Submitted For Construction Revisions 
 
 

Tier 1 Projects 
 

Tier 2 Projects 
 

Bridge Plans As Builts Tier 1 
 

Bridge Plans As Builts Tier 2 
 

http://www.extranet.vdot.state.va.us/locdes/2-Tier_Process_Review/Advertisement_Submission/Electronic_Advertisement_Submission-T1.pdf
http://www.extranet.vdot.state.va.us/locdes/2-Tier_Process_Review/Advertisement_Submission/Electronic_Advertisement_Submission-T2.pdf
http://www.virginiadot.org/business/resources/LocDes/EPlans/Electronic_Submission_of_Pre-Award_Revisions_-_Tier_1.pdf
http://www.virginiadot.org/business/resources/LocDes/EPlans/Electronic_Submission_of_Pre-Award_Revisions_-_Tier_2.pdf
http://www.extranet.vdot.state.va.us/locdes/2-Tier_Process_Review/Construction_Revisions/Electronic_Submission_of_Construction_and_Bridge_Revisions-T1.pdf
http://www.extranet.vdot.state.va.us/locdes/2-Tier_Process_Review/Construction_Revisions/Electronic_Submission_of_Construction_and_Bridge_Revisions-T2.pdf
http://www.extranet.vdot.state.va.us/locdes/2-Tier_Process_Review/Construction_Revisions/As_Built_Bridge_Plan_Submittal_Procedure_T1.pdf
http://www.extranet.vdot.state.va.us/locdes/2-Tier_Process_Review/Construction_Revisions/As_Built_Bridge_Plan_Submittal_Procedure_T2.pdf
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E.2.1.4 Illustrations & Procedures for Filling out Database Information  
The following screen captures show the required fields as they will appear in Falcon 
DocMan. There are times when the field may be left blank. Please read the following 
carefully. 
 
Most of the fields are self-explanatory. However, a few do require 
examples:  

Falcon General Screen 
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E.2.1.5 File Format Keywords Tab  
 
All files with the status set to “Index” must have Engineer, Designer, District, and County 
filled in. If the Engineer and Designer are the same person, then the “Designer” field is 
not required and may be left blank.  

The “Engineer” field should be filled in with the name of the Supervisor of the section or 
the Sr. Engineer who is overseeing the design.  

The “Generate PDF” field should be filled in when pdf files are to be generated. The 
appropriate project stage should be chosen from the list shown. 
 

 

 

 

 

GENERATE PDF - Several choices – 
Choose the “stage” that applies to your 
current submission.  

 

SCALE FACTOR – used by Survey only 
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E.2.1.6 General Information Tab  

The “Description” field must be filled in and for S&B plans should be filled in with the 
title of the sheet (ex. Abutment A). For L&D plans should be filled in with the sheet 
description (ex. Sheet No. 3 Sta. 100+00 to Sta. 500+00). The “Sheet #” should 
ALWAYS be filled in with the FINAL sheet number that applies to the plan unless the 
sheet is a worksheet or a file that will not be included in the plans, in which case it 
should be left blank. This may require that the number be modified prior to indexing or 
archiving. If the sheet number is 1 thru 9 place a zero in front of the sheet number. 
(For example if the sheet number is 2e the Sheet # should be 02e.)  

 The “Status” field has several choices: index, active, and survey. The field must be 
set to “index” only when the file is going to be a part of the plan assembly. Otherwise 
set the field to “active”. The “survey” setting is for locking down the survey file when it 
is being edited. Do not change status field if set to survey.  

E.2.1.7 General Information Tab Tips 

 

 

L&D uses a leading 0 (01-09) 

S&B uses a leading 00 (001-009) 

SHEET # - Use “leading” zeroes to 
allow all plan sets to be uniformly 
numbered and sequentially displayed.  

(Also to be used to indicate a Revision 
or As-Built)  

• If sheet one is “at 2
nd 

revision”, 
this would be 001r2.  

• If sheet one is “at As-built”, the 
field would be 001rab.  

STATUS – All sheets to be included in 
the plan set should be set to INDEX. 
(Scratch sheets, etc. should NOT be set 
to INDEX.) Otherwise set the field to 
“active”. The “survey” setting is for 
locking down the survey file when it is 
being edited.  Do not change status 
field if set to survey.  
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E.2.1.8 Title Block Tab 

 No data fields required for L&D 

The Title Block provides six additional fields that can be used by S & B for indexing. 

 

 

Federal Structure # - (a five digit identifier)  

 

See Mass Update information on Page 8 of this 
document. 

 

RECORD SERIES # 

Road plans 501-003-1336 

http://bioapp13/RecordsRetention/Pages/SearchSeries.aspx 

Bridge plans 501-016-1016  
http://bioapp13/RecordsRetention/Pages/SearchSeries.aspx 

District SAAP & RAAP 501-003-1060  
http://bioapp13/RecordsRetention/Pages/SearchSeries.aspx 

 

 

E.2.1.9 Keywords Tab 

The “Archive” field is required to be used only when you are ready to archive a set of 

files, otherwise it should be left blank. Instructions about the “Archive” field are shown 

in more detail below. All files with the “Status” set to index must have the Route, 

County/City, Section, SB Plan #, and C# or M# etc filled in. The route number will 
always be four digits. The Structure & Bridge # (SB Plan #) is used for Bridge Plans 

only. 

 

http://bioapp13/RecordsRetention/Pages/SearchSeries.aspx
http://bioapp13/RecordsRetention/Pages/SearchSeries.aspx
http://bioapp13/RecordsRetention/Pages/SearchSeries.aspx
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ARCHIVE – To be used by S&B for 
projects at the following stages: 

• Adv Submission 
• Pre Award Revision 
• Construction Revision 
• As-Built 
ROUTE # should be four digits 

(e.g. Interstate 395 would be 0395) 
 

These fields are used to re-name the 
PDF files to the project number. 

 

E.2.2 Archiving Files   

The following instructions are for archiving your files. Archiving your files will give you 
a complete copy of your project at that particular stage of development. After all of the 
“required” database fields are filled out, you are ready to archive the project. In the 
“Keywords” tab, set the “Archive” to the appropriate project development stage for all 
project files. Only change the Archive when you are ready to archive the file, otherwise 
leave it blank.  

Falcon will copy all of the files that have the “Archive” field set to an Archives 
environment on a Falcon server. This process will run nightly. When the process has 
finished, the “Archive” field will automatically return to a blank status. This will allow 
for files to be archived at different stages. These files can be accessed for viewing and 
printing but cannot be changed when in the Archives environment.  

Files archived at Advertisement Submission, Revisions (Pre-Award or 
Construction) are available to the contractors on the external Falcon Web. So it’s 

very important to archive files at these stages. 
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E.2.2.1 Archive Stages 

The following shows what types of files shall be archived for the respective Project 
Development stages: 

# Preliminary Field Inspection – GEOPAK* and DGN files 

# Public Hearing – GEOPAK* and DGN files  

# Right of Way Total – GEOPAK* and DGN files  

# Field Inspection Stage – GEOPAK* and DGN files  

Right of Way Partial – GEOPAK* and DGN files  

# Adv Submission – GEOPAK* and DGN, and all related files necessary for 
the contractor to build the project.  

Pre Award Revision – All revised files  

Construction Revision – All revised files  

As Built Plans – All plan DGN files for the project  

# Note: See VDOT Drainage Manual Section 3.3.3 schedule for additional       
Hydraulic Files to be archived.∗ 

* Note: Please contact CADD Support  Helpdesk to Archive any GEOPAK files. 

S&B will always archive files at Advertisement Submission, Revisions (Pre-Award 
or Construction) and As Builts and may occasionally need to archive files at one of 
the other stages, depending on the project. See Chapter 1 Section 1.6.2 for more 
information on Archiving As-Builts. Please note that only DGN files are archived. 

E.2.2.2 Assessing Archived Files 

Databases should be set to Central.  

Environments should be set to archives.  

 After setting the environment to Archives, choose “UPC#”, then “Stage”, then “Division”. 
Stage could be any of the plan stages noted in the Archive choices described previously.  
 

The files that have been archived for that stage will be available. These files are read only 
and cannot be edited. Use the View button to access these files for reviewing and 
plotting.  
                                                      

∗ Rev 1/17 
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E.2.2.3 Example Index of Files  

An Index of files should be requested for all projects and will show the information entered 
on the General Information Tab. The Reference File column will show the files attached as 
reference.  

This is an example of a Structure & Bridge index∗.  

  

Mass Update Tool in Windows Document Manager  

The Mass Update tool can be used to change database information on multiple files. 
Highlight the files in the Files Select window and go to Tools > Mass Update. This only 
changes the database fields that you enter data into. All other fields remain as they are. 
Once all the data is entered, select Process.  

Refer to the Instructions for Mass Update in Falcon in Section E 1.5 for more 
information.  
                                                      

∗ Rev 2/18 
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E.3 Using Falcon to access C.O. Plan File Room 

E.3.1 Falcon Plan File Room access thru Windows 

Completed plans are accessed through the Plan File room, since the files that you will 
be accessing are TIF and PDF image files; the following screen captures are showing 
the Windows version (Document Manager) of Falcon instead of the MicroStation 
MDL version. 

To access Falcon, go to Start, then Programs, then FalconDMSv6, then Doc.Man  

  

 

 

When the Falcon Dialog box opens up, click on Databases, then Open Databases. 
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Then choose Central Office. 

 

 

Once you are in the Central Office Database go to Environments, then Plan File 
Room. 
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When the window opens click on the little pulse beside Projects, then pick road 
plans. 

                     

 

And then click on the District that the project is located in. 
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When the projects show up in the window, use the down arrow to find the project that 
you are interested in and then double click on that folder. 

           

Files should show up in the File Names field. File names are set up using the base 
project number, the sheet number, and the .tif extension for the older projects and a 
.pdf extension for projects entered into the Plan File room after. When you select a file 
the database tabs at the right will show appropriate information. 

         

 



VDOT CADD Manual 
 

E-34 of 39 Accessing C.O. Plan File Room 

 

   

 

For additional information on File naming conventions for the Plan file room see 
Chapter 1 Section 1.5. 
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E.3.2 Project Database Information 

Filled out Database information should be as shown below. This information is necessary 
for an accurate and fast search. 

          

 

Note: PPMS # has been replaced by the name UPC#. 
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E.3.3 Search Engine 

If you are not sure of the project District, number, etc., then you can use Falcon’s 
search engine to find it. To start the search, click on the Search: 

            

 

You may search the database by choosing any one of the fields and keying-in known 
information in the blank field. The following screen captures show an example: 
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Once you have filled in the appropriate field, click on the Find button to initiate the 
search. If the search is successful, Falcon should give you a choice list of all the files that 
match your search request. 
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E.3.4 Viewing Projects 
When you have found the project information you were looking for, click on the file 
that you wish to view, then right mouse click on the Open (View) for older projects in 
.tif format. For pdf’s just click on the image to open, make sure you have a pdf 
reader installed Instructions below are for TIFFS only.. 

 

 

 

 A Select Application dialog box will appear. Select imag_office2003, and then click 
on the OK button. 
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The file will open in an application called Imaging, which will view and print the file 
only. These are TIFF image files and they are not editable. 

   

PDF files will open when you click on them. 
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